
 

 

ĐỀ CƯƠNG CUỐI KỲ I NĂM HỌC 2023 -2024 

MÔN: TIN HỌC 12 

 

A. NỘI DUNG: 

     1. Khái niệm về cơ sở dữ liệu  và hệ quản trị CSDL 

-Trình bày được khái niệm CSDL 

-Nêu được vai trò của CSDL trong học tập và cuộc sống 

- Lấy được ví dụ về bài toán quản lí trong thực tế để minh họa cho CSDL 

- Giải thích được vai trò của CSDL trong học tập và cuộc sống thông qua  các ví dụ cụ thể  

2.Hệ quản trị CSDL: 

 - Trình bày được khái niệm hệ QT CSDL 

 - Nêu được các chức năng của hệ quản trị CSDL (tạo lập CSDL; cập nhật dữ liệu, tìm kiếm, kết xuất 

thông tin; điều  khiển việc truy cập vào CSDL) 

- Nêu được vai trò của con người khi làm việc với hệ 

- Nêu được ví dụ cụ thể về hệ QT CSDL 

- Giải thích được các chức năng của hệ QT CSDL thông  qua ví dụ minh họa. 

- Giải thích được vai trò của con người khi làm việc với hệ CSDL (theo một trong 3 vai trò: người 

quản trị, người lập trình ứng dụng và người dùng.Chỉ ra được các công việc cụ thể thường phải làm 

khi tạo lập CSDL (cập nhật dữ liệu, tìm kiếm, kết xuất thông tin, điều khiển việc truy cập vào CSDL 

3.Giới thiệu MS ACCESS: 

- Nêu được khái niệm Access 

- Nêu được các chức năng chính của Access 

- Nêu được bốn đối tượng chính của CSDL: bảng, mẫu hỏi, biểu mẫu và báo cáo 

- Nêu được hai chế độ làm việc với các đối tượng của CSDL: Chế độ thiết kế và chế độ trang dữ 

liệu. 

- Nêu được cách thực hiện các thao tác: khởi động và ra khỏi Access. 

- Tạo CSDL mới, mở CSDL đã có 

- Nhận ra và nêu được tác dụng, ý nghĩa của các chức năng chính của ACCESS:  

- Tạo lập bảng, thiết lập mối liên kết giữa các bảng, cập nhật và kết xuất thông tin.             

 

4.Cấu trúc bảng: 

 - Trình bày được các khái niệm chính sau đây trong cấu trúc dữ liệu bảng thông qua ví dụ minh họa: 

+Cột (trường/thuộc tính): tên, miền giá trị. +Hàng (bản ghi/bộ): bộ các giá trị của các thuộc tính. + 

Khoá chính. 

 - Nêu được cách tạo và sửa cấu trúc bảng. 

 - Giải thích được tác dụng của việc liên kết giữa các bảng 

 - Thực hiện được thao tác tạo và sửa cấu trúc bảng, cập nhật dữ liệu. 

 - Thực hiện được thao tác khai báo khoá chính. 

5. Các thao tác cơ bản trên bảng:  

 - Biết các lệnh làm việc với bảng, cập nhật dữ liệu, sắp xếp và lọc dữ liệu, tìm kiếm đơn giản. 

 - Thực hiện được mở bảng ở chế độ trang dữ liệu, cập nhật dữ liệu, sắp xếp và lọc, tìm kiếm đơn 

giản.  

6. Biểu mẫu: 

 - Nêu được khái niệm và vai trò của biểu mẫu. Biết các lệnh làm việc với biểu mẫu. 

 - Trình bày được các bước chính để tạo ra một biểu mẫu  

 -  Giải thích được vai trò, ý nghĩa của biểu mẫu. 

7. Liên kết giữa các bảng: 

 - Hiểu khái niệm liên kết giữa các bảng. 



 

 

 - Nắm vững kỹ thuật tạo liên kết giữa các bảng. 

8. Mẫu hỏi: 

 - Nêu được khái niệm và vai trò của mẫu hỏi. Biết các lệnh làm việc với mẫu hỏi 

 - Trình bày được các bước chính để tạo ra một mẫu hỏi 

 - Giải thích được vai trò, ý nghĩa của mẫu hỏi. 

B .PHẦN TRẮC NGHIỆM 

BÀI 1: MỘT SỐ KHÁI NIỆM CƠ BẢN 

 

Câu 1: Công việc thường gặp khi xử lí thông tin của một tổ chức là gì?  

A. Tạo lập hồ sơ   B. Cập nhật hồ sơ C. Khai thác hồ sơ D. Tạo lập, cập nhật, khai thác hồ sơ 

Câu 2: Việc lưu trữ dữ liệu đầy đủ và hợp lí sẽ: 

A. Hỗ trợ thống kê, báo cáo, tổng hợp số liệu.  B. Hỗ trợ ra quyết định 

C. Cả A và B đều đúng    D. Cả A và B đều sai. 

Câu 3: Cần tiến hành cập nhật hồ sơ học sinh của nhà trường trong các trường hợp nào sau đây? 

A. Một học sinh mới chuyển từ trường khác đến; thông tin về ngày sinh của một học sinh bị sai. 

B. Sắp xếp danh sách học sinh theo thứ tự tăng dần của tên 

C. Tìm học sinh có điểm môn toán cao nhất khối. 

D. Tính tỉ lệ học sinh trên trung bình môn Tin của từng lớp. 

Câu 4: Dữ liệu trong một CSDL được lưu trong: 

A. Bộ nhớ RAM B. Bộ nhớ ROM  C. Bộ nhớ ngoài D. Các thiết bị vật lí 

Câu 5: Việc xác định cấu trúc hồ sơ được tiến hành vào thời điểm nào? 

A. Trước khi thực hiện các phép tìm kiếm, tra cứu thông tin  

B. Cùng lúc với việc nhập và cập nhật hồ sơ 

C. Sau khi đã nhập các hồ sơ vào máy tính   

D. Trước khi nhập hồ sơ vào máy tính 

Câu 6: Xét công tác quản lí hồ sơ. Trong số các công việc sau, những việc nào không thuộc nhóm thao 

tác cập nhật hồ sơ? 

A. Xóa một hồ sơ    B. Thống kê và lập báo cáo  

C. Thêm hai hồ sơ    D. Sửa tên trong một hồ sơ. 

Câu 7: Cơ sở dữ liệu (CSDL) là : 

A. Tập hợp dữ liệu chứa đựng các kiểu dữ liệu: ký tự, số, ngày/giờ, hình ảnh... của một chủ thể nào đó. 

B. Tập hợp dữ liệu có liên quan với nhau theo một chủ đề nào đó được ghi lên giấy. 

C. Tập hợp dữ liệu có liên quan với nhau theo một chủ đề nào đó được lưu trên máy tính điện tử để đáp ứng 

nhu cầu khai thác thông tin của nhiều người. 

D. Tập hợp dữ liệu có liên quan với nhau theo một chủ đề nào đó được lưu trên giấy để đáp ứng nhu cầu khai 

thác thông tin của nhiều người. 

Câu 8: Hệ quản trị CSDL là: 

A. Phần mềm dùng tạo lập, cập nhật, lưu trữ và khai thác thông tin của CSDL 

B. Phần mềm dùng tạo lập, lưu trữ một CSDL 

C. Phần mềm để thao tác và xử lý các đối tượng trong CSDL 

D. Phần mềm dùng tạo lập CSDL 

Câu 9: Em hiểu như thế nào về cụm từ  “Hệ quản trị cơ sở dữ liệu” ? 

A. Hệ quản trị cơ sở dữ liệu là một loại thiết bị hỗ trợ màn hình máy tính 

B. Hệ quản trị cơ sở dữ liệu là một loại thiết bị hỗ trợ mạng máy tính 

C. Hệ quản trị cơ sở dữ liệu là một loại dữ liệu được lưu trữ trên máy tính 

D. Hệ quản trị cơ sở dữ liệu là một loại phần mềm máy tính 

Câu 10: Một Hệ CSDL gồm: 

A. CSDL và các thiết bị vật lí. B. Các phần mềm ứng dụng và CSDL. 

C. Hệ QTCSDL và các thiết bị vật lí. D. CSDL và hệ QTCSDL quản trị và khai thác CSDL đó. 

Câu 11: Hoạt động nào sau đây có sử dụng CSDL? 

A. Bán vé máy bay    B. Quản lý học sinh trong nhà trường   

C. Bán hàng có quy mô   D. Tất cả đều đúng 

Câu 12: Hãy nêu các ưu điểm khi sử dụng CSDL trên máy tính điện tử: 



 

 

A. Gọn, thời sự (Cập nhật đầy đủ, kịp thời...) 

B. Gọn, nhanh chóng 

C. Gọn, thời sự, nhanh chóng, nhiều nguời có thể sử dụng chung CSDL 

D. Gọn, thời sự, nhanh chóng 

Câu 13: Khai thác hồ sơ gồm có những việc chính nào? 

A. Sắp xếp, tìm kiếm B. Thống kê, lập báo cáo C. Sắp xếp, tìm kiếm, thống kê D. Cả A và B 

Câu 14: Xét tệp lưu trữ hồ sơ học bạ của học sinh, trong đó lưu trữ điểm tổng kết của các môn Văn, 

Toán, Lí, Sinh, Sử, Địa. Những việc nào sau đây không thuộc thao tác tìm kiếm? 

A. Tìm học sinh có điểm tổng kết môn Văn cao nhất 

B. Tìm học sinh có điểm tổng kết môn Toán thấp nhất 

C. Tìm học sinh có điểm trung bình sáu môn cao nhất 

D. Tìm học sinh nữ có điểm môn Toán cao nhất và học sinh nam có điểm môn Văn cao nhất 

Câu 15: Xét tệp hồ sơ học bạ của một lớp. Các hồ sơ được sắp xếp giảm dần theo điểm trung bình của 

học sinh. Việc nào nêu dưới đây đòi hỏi phải duyệt tất cả các hồ sơ trong tệp? 

A. Tìm học sinh có điểm trung bình cao nhất, thấp nhất 

B. Tính điểm trung bình của tất cả học sinh trong lớp 

C. Tính và so sánh điểm TB của các học sinh nam và điểm TB của các học sinh nữ trong lớp 

D. Cả B và C 

Câu 16: Sau khi thực hiện tìm kiếm thông tin trong một tệp hồ sơ học sinh, khẳng định nào sau đây là 

đúng? 

A. Trình tự các hồ sơ trong tệp không thay đổi 

B. Tệp hồ sơ có thể xuất hiện những hồ sơ mới 

C. Trình tự các hồ sơ trong tệp không thay đổi, nhưng những thông tin tìm thấy đã được lấy ra nên không 

còn trong những hồ sơ tương ứng 

D. Những hồ sơ tìm được sẽ không còn trên tệp vì người ta đã lấy thông tin ra 

Câu 17: Những khẳng định nào sau đây là sai? 

A. Tìm kiếm là việc tra cứu các thông tin không có sẵn trong hồ sơ thỏa mãn một số điều kiện nào đó 

B. Thống kê là cách khai thác hồ sơ dựa trên tính toán để đưa ra các thông tin đặc trưng, không có sẵn trong 

hồ sơ 

C. Lập báo cáo là việc sử dụng các kết quả tìm kiếm, thống kê, sắp xếp các bộ hồ sơ để tạo lập một bộ hồ sơ 

mới có nội dung và cấu trúc khuôn dạng theo một yêu cầu cụ thể nào đó, thường để in ra giấy 

D. Sắp xếp hồ sơ theo một tiêu chí nào đó phù hợp với yêu cầu quản lý của tổ chức 

 

 

BÀI 2: HỆ QUẢN TRỊ CƠ SỞ DỮ LIỆU 

 

Câu 1: Một hệ quản trị CSDL không có chức năng nào trong các chức năng dưới đây? 

A. Cung cấp môi trường tạo lập CSDL 

B. Cung cấp môi trường cập nhật và khai thác dữ liệu 

C. Cung cấp công cụ quản lí bộ nhớ 

D. Cung cấp công cụ kiểm soát, điều khiển truy cập vào CSDL. 

Câu 2: Ngôn ngữ định nghĩa dữ liệu thật chất là: 

A. Ngôn ngữ lập trình Pascal     B. Ngôn ngữ C 

C. Các kí hiệu toán học dùng để thực hiện các tính toán D. Hệ thống các kí hiệu để mô tả CSDL 

Câu 3: Ngôn ngữ định nghĩa dữ liệu bao gồm các lệnh cho phép: 

A. Đảm bảo tính độc lập dữ liệu 

B. Khai báo kiểu dữ liệu, cấu trúc dữ liệu và các ràng buộc trên dữ liệu của  CSDL 

C. Mô tả các đối tượng được lưu trữ trong CSDL 

D. Khai báo kiểu dữ liệu của CSDL 

Câu 4: Ngôn ngữ thao tác dữ liệu thật chất là: 



 

 

A. Ngôn ngữ để người dùng diễn tả yêu cầu cập nhật hay khai thác thông tin 

B. Ngôn ngữ để người dùng diễn tả yêu cầu cập nhật thông tin 

C. Ngôn ngữ SQL 

D. Ngôn ngữ bậc cao 

Câu 5: Ngôn ngữ thao tác dữ liệu bao gồm các lệnh cho phép: 

A. Nhập, sửa, xóa dữ liệu 

B. Khai báo kiểu, cấu trúc, các ràng buộc trên dữ liệu của  CSDL 

C. Khai thác dữ liệu như: tìm kiếm, sắp xếp, kết xuất báo cáo… 

D. Câu A và C  

Câu 6: Ngôn ngữ CSDL được sử dụng phổ biến hiện nay là: 

A. SQL   B. Access   C. Foxpro   D. Java 

Câu 7: Những nhiệm vụ nào dưới đây không thuộc nhiệm vụ của công cụ kiểm soát, điều khiển truy 

cập vào CSDL? 

A. Duy trì tính nhất quán của CSDL  B. Cập nhật (thêm, sửa, xóa dữ liệu) 

C. Khôi phục CSDL khi có sự cố  D. Phát hiện và ngăn chặn sự truy cập không được phép 

Câu 8: Hệ QT CSDL có các chương trình thực hiện những nhiệm vụ: 

A. Phát hiện và ngăn chặn sự truy cập không được phép, tổ chức và điều khiển các truy cập đồng thời 

B. Duy trì tính nhất quán của dữ liệu, quản lý các mô tả dữ liệu 

C. Khôi phục CSDL khi có sự cố ở phần cứng hay phần mềm 

D. Cả 3 đáp án A, B và C 

Câu 9: Khẳng định nào sau đây là đúng? 

A. Hệ QT CSDL là một bộ phận của ngôn ngữ CSDL, đóng vai trò chương trình dịch cho ngôn ngữ CSDL 

B. Người lập trình ứng dụng không được phép đồng thời là người quản trị hệ thống vì như vậy vi phạm quy 

tắc an toàn và bảo mật 

C. Hệ QT CSDL hoạt động độc lập, không phụ thuộc vào hệ điều hành 

D. Người quản trị CSDL phải hiểu biết sâu sắc và có kĩ năng tốt trong các lĩnh vực CSDL, hệ QT CSDL và 

môi trường hệ thống 

Câu 10: Người nào đã tạo ra các phần mềm ứng dụng đáp ứng nhu cầu khai thác thông tin từ CSDL? 

A. Người dùng B. Người  lập trình ứng dụng 

C. Người QT CSDL D. Cả ba người trên 

Câu 11: Người nào có vai trò quan trọng trong vấn đề phân quyền hạn truy cập sử dụng CSDL? 

A. Người lập trình B. Người dùng 

C. Người quản trị D. Nguời quản trị CSDL 

Câu 12: Trong vai trò của con người khi làm việc với các hệ CSDL, người thiết kế và cấp phát quyền 

truy cập cơ sở dữ liệu, là người ? 

A. Người lập trình ứng dụng                         B. Người sử dụng (khách hàng) 

C. Người quản trị cơ sở dữ liệu       D. Người bảo hành các thiết bị phần cứng của máy tính 

Câu 13: Chức năng của hệ QTCSDL? 

A. Cung cấp cách khai báo dữ liệu 

B. Cung cấp môi trường tạo lập CSDL và  công cụ kiểm soát, điều khiển việc truy cập vào CSDL. 

C. Cung cấp cách cập nhật dữ liệu, tìm kiếm và kết xuất thông tin 

D. Câu B và C 

Câu 14: Quy trình xây dựng CSDL là: 

A. Khảo sát  Thiết kế  Kiểm thử   B. Khảo sát  Kiểm thử  Thiết kế 

C. Thiết kế  Kiểm thử  Khảo sát   D. Thiết kế  Khảo sát  Kiểm thử 

 

ĐÁP ÁN: 

 

BÀI 3: GIỚI THIỆU VỀ MICROSOFT ACCESS 

 

Câu 1: Access là gì? 



 

 

A. Là phần mềm ứng dụng B. Là hệ QTCSDL do hãng Microsoft sản xuất 

C. Là phần cứng D. Cả A và B 

Câu 2: Access là hệ QT CSDL dành cho: 

A. Máy tính cá nhân B. Các mạng máy tính trong mạng toàn cầu 

C. Các máy tính chạy trong mạng cục bộ D. Cả A và C 

Câu 3: Các chức năng chính của Access? 

A. Lập bảng B. Tính toán và khai thác dữ liệu 

C. Lưu trữ dữ liệu D. Ba câu trên đều đúng 

Câu 4: Access có những khả năng nào? 

A. Cung cấp công cụ tạo lập, lưu trữ dữ liệu  

B. Cung cấp công cụ tạo lập, cập nhật và khai thác dữ liệu  

C. Cung cấp công cụ tạo lập, lưu trữ và khai thác dữ liệu 

D. Cung cấp công cụ tạo lập, lưu trữ, cập nhật và khai thác dữ liệu  

Câu 5: Các đối tượng cơ bản trong Access là: 

A. Bảng, Macro, Biểu mẫu, Mẫu hỏi B. Bảng, Macro, Biểu mẫu, Báo cáo 

C. Bảng, Mẫu hỏi, Biểu mẫu, Báo cáo D. Bảng, Macro, Môđun, Báo cáo 

Câu 6: Trong Access có mấy đối tượng cơ bản? 

A. 4 B. 2 C. 3 D. 1 

Câu 7: Chọn câu sai trong các câu sau: 

A. Access có khả năng cung cấp công cụ tạo lập CSDL 

B. Access không hỗ trợ lưu trữ CSDL trên các thiết bị nhớ. 

C. Access cho phép cập nhật dữ liệu, tạo báo cáo, thống kê, tổng hợp. 

D. CSDL xây dựng trong Access gồm các bảng và liên kết giữa các bảng. 

Câu 8: Để định dạng, tính toán, tổng hợp và in dữ liệu, ta dùng: 

A. Table B. Form C. Query D. Report 

Câu 9: Để sắp xếp, tìm kiếm và kết xuất dữ liệu xác định từ một hoặc nhiều bảng, ta dùng: 

A. Table B. Form C. Query D. Report 

Câu 10: Đối tượng nào tạo giao diện thuận tiện cho việc nhập hoặc hiển thị thông tin? 

A. Table B. Form C. Query D. Report 

Câu 11: Đối tượng nào có chức năng dùng để lưu dữ liệu? 

A. Table B. Form C. Query D. Report 

Câu 12: Để khởi động Access, ta thực hiện: 

A. Nháy đúp vào biểu tượng Access  trên màn hình nền 

B. Nháy vào biểu tượng Access  trên màn hình nền 

C. Start  All Programs  Microsoft Office  Microsoft Access 

D. A hoặc C 

Câu 13: Để tạo một CSDL mới và đặt tên tệp trong Access, ta phải: 

A. Khởi động Access, vào File chọn New hoặc kích vào biểu tượng New 

B. Vào File chọn New 

C. Kích vào biểu  tượng New 

D. Khởi động Access, vào File chọn New hoặc kích vào biểu tượng New, kích tiếp vào Blank DataBase, rồi 

đặt tên file và chọn vị trí lưu tệp, rồi sau đó chọn Create 

Câu 14: Hãy sắp xếp các bước sau để được một thao tác đúng khi tạo một CSDL mới? 

(1) Chọn nút Create    ( 2) Chọn File -> New      (3) Nhập tên cơ sở dữ liệu      (4) Chọn Blank Database 

A. (2)  (4)  (3)  (1)    B. (2)  (1)  (3)  (4)      

C. (1)  (2)  (3)  (4) D. (1)  (3)  (4)  (2) 

Câu 15: Trong Access, để tạo CSDL mới, thao tác thực hiện lệnh nào sau đây là đúng? 

A. Create Table in Design View B. Create table by using wizard 

C. File/open D. File/New/Blank Database 

Câu 16: Tên của CSDL trong Access bắt buộc phải đặt trước hay sau khi tạo CSDL? 

A. Đặt tên tệp sau khi đã tạo CSDL                  B. Vào File /Exit 

C. Vào File /Close                                             D. Bắt buộc vào là đặt tên tệp ngay rồi mới tạo CSDL sau 



 

 

Câu 17: Trong Acess, để mở CSDL đã lưu, thao tác thực hiện lệnh nào sau đây là đúng? 

A. File/new/Blank Database B. Create table by using wizard 

C. File/open/<tên tệp> D. Create Table in Design View  

Câu 18: Giả sử đã có tệp Access trên đĩa, để mở tập tin đó thì ta thực hiện thao tác nào mới đúng? 

A. Nhấn tổ hợp phím CTRL+ O B. Nháy đúp chuột lên tên của CSDL (nếu có) trong khung New File 

C. File/Open D. Cả A, B và C đều đúng 

Câu 19: Kết thúc phiên làm việc với Access bằng cách thực hiện thao tác: 

A. File/Close  B. Nháy vào nút (X) nằm ở góc trên bên phải màn hình làm việc của Access 

C. File/Exit  D. Câu B hoặc C 

Câu 20: Có mấy chế độ chính để làm việc với các loại đối tượng? 

A. 5 chế độ B. 3 chế độ  C. 4 chế độ  D. 2 chế độ 

Câu 21: Hai chế độ chính làm việc với các đối tượng là: 

A. Trang dữ liệu và thiết kế B. Chỉnh sửa và cập nhật  

C. Thiết kế và bảng D. Thiết kế và cập nhật 

Câu 22: Chế độ thiết kế được dùng để: 

A. Tạo mới hay thay đổi cấu trúc của bảng, mẫu hỏi; thay đổi cách trình bày và định dạng biểu mẫu, báo cáo 

B. Cập nhật dữ liệu cho của bảng, mẫu hỏi; thay đổi cách trình bày và định dạng biểu mẫu, báo cáo 

C. Tạo mới hay thay đổi cấu trúc của bảng, mẫu hỏi; hiển thị dữ liệu của biểu mẫu, báo cáo 

D. Tạo mới hay thay đổi cấu trúc của bảng, mẫu hỏi, biểu mẫu và báo cáo 

Câu 23: Chế độ trang dữ liệu được dùng để: 

A. Tạo mới hay thay đổi cấu trúc của bảng, mẫu hỏi; thay đổi cách trình bày và định dạng biểu mẫu, báo cáo 

B. Cập nhật dữ liệu cho của bảng, mẫu hỏi; thay đổi cách trình bày và định dạng biểu mẫu, báo cáo 

C. Hiển thị dữ liệu của biểu mẫu, báo cáo; thay đổi cấu trúc bảng, mẫu hỏi 

D. Hiển thị dữ liệu dạng bảng, cho phép xem, xóa hoặc thay đổi các dữ liệu đã có 

Câu 24: Trong chế độ trang dữ liệu, ta có thể chuyển sang chế độ thiết kế bằng cách dùng menu: 

A. Format→Design View  B. View→Design View  

C. Tools→Design View  D. Edit →Design View  

Câu 25: Để chuyển đổi qua lại giữa chế độ trang dữ liệu và chế độ thiết kế, ta nháy nút: 

A.    B.    C.   hoặc   D.  

Câu 26: Một đối tượng trong Access có thể được tạo ra bằng cách: 

A. Người dùng tự thiết kế, dùng thuật sĩ hoặc kết hợp cả 2 cách trên B. Người dùng tự thiết kế 

C. Kết hợp thiết kế và thuật sĩ       D. Dùng các mẫu dựng sẵn 

Câu 27: Để tạo một đối tượng trong Access, trước tiên ta phải nháy chọn một đối tượng cần tạo trong 

bảng chọn đối tượng, rồi tiếp tục thực hiện: 

A. Nháy nút  …    

B. Nháy chọn  một trong các cách (tự thiết kế, dùng thuật sĩ, kết hợp giữa thuật sĩ và thiết kế) trong trang 

bảng 

C. Đáp án A, B đều đúng 

D. Đáp án A, B đều sai 

Câu 28: Người ta thường sử dụng cách nào để tạo một đối tượng mới (table)? 

A. Create table in Design view   B. Create table by using wizard 

C. Create table by entering data   D. Create form in Design view  

Câu 29: Để mở một đối tượng, trong cửa sổ của loại đối tượng tương ứng, ta thực hiện: 

A. Nháy lên tên một đối tượng rồi tiếp tục nháy nút  để mở nó  

B. Nháy lên tên một đối tượng để mở nó 

C. Nháy đúp lên tên một đối tượng để mở nó  

D. Đáp án A hoặc C  

Câu 30: Phần đuôi của tên tập tin trong Access là 

A. MDB  B. DOC  C. XLS   D. TEXT 

Câu 31: MDB viết tắt bởi 

A. Không có câu nào đúng B. Manegement DataBase 

C. Microsoft DataBase D. Microsoft Access DataBase 

 



 

 

ĐÁP ÁN: 

 

BÀI 4: CẤU TRÚC BẢNG 

 

Câu 1: Thành phần cơ sở của Access là: 

A. Table B. Field C. Record D. Field name 

Câu 2: Trong Access, muốn làm việc với đối tượng bảng, tại cửa sổ cơ sở dữ liệu ta chọn nhãn : 

A. Queries B. Reports C. Tables D. Forms 

Câu 3: Để mở một bảng ở chế độ thiết kế, ta chọn bảng đó rồi: 

A. Click vào nút  B. Bấm Enter 

C. Click vào nút  D. Click vào nút  

Câu 4: Trong các phát biểu sau, phát biểu nào sai? 

A. Trường (field): bản chất là cột của bảng, thể hiện thuộc tính của chủ thể cần quản lý 

B. Bản ghi (record): bản chất là hàng của bảng, gồm dữ liệu về các thuộc tính của chủ thể được quản lý 

C. Kiểu dữ liệu (Data Type): là kiểu của dữ liệu lưu trong một trường 

D. Một trường có thể có nhiều kiểu dữ liệu 

Câu 5: Trong Access, một bản ghi được tạo thành từ dãy: 

A.Trường  B.Cơ sở dữ liệu  C.Tệp   D.Bản ghi khác 

Câu 6: Phát biểu nào sau là đúng nhất ? 

A. Record  là tổng số hàng của bảng B. Data Type là kiểu dữ liệu trong một bảng 

C. Table gồm các cột và hàng D. Field là tổng số cột trên một bảng 

Câu 7: Trong Access, khi nhập dữ liệu cho bảng, giá trị của field GIOI_TINH là True. Khi đó field 

GIOI_TINH được xác định kiểu dữ liệu gì ? 

A.Yes/No   B.Boolean   C.True/False  D.Date/Time 

Câu 8: Khi chọn kiểu dữ liệu cho trường THÀNH_TIỀN (bắt buộc kèm theo đơn vị tiền tệ), phải  chọn 

loại nào? 

A. Number B. Currency C. Text D. Date/time 

Câu 9: Khi chọn dữ liệu cho các trường chỉ chứa một trong hai giá trị như: trường “gioitinh”, trường  

“đoàn viên”, ...nên chọn kiểu dữ liệu nào để sau này nhập dữ liệu cho nhanh. 

A. Number B. Text C. Yes/No D. Auto Number 

Câu 10: Đâu là kiểu dữ liệu văn bản trong Access: 

A. Character   B. String  C. Text  D. Currency 

Câu 11: Chọn kiểu dữ liệu nào cho truờng điểm “Tóan”, “Lý”,... 

A. AutoNumber B. Yes/No C. Number D. Currency 

Câu 12: Trong Access, dữ liệu kiểu ngày tháng được khai báo bằng: 

A. Day/Type B. Date/Type C. Day/Time D. Date/Time 

Câu 13: Trong Access khi ta nhập dữ liệu cho trường “Ghi chú” trong CSDL (dữ liệu kiểu văn bản) 

mà nhiều hơn 255 kí tự thì ta cần phải định nghĩa trường đó theo kiểu nào? 

A. Text   B. Currency  C. Longint  D. Memo 

Câu 14: Trong của sổ CSDL đang làm việc, để tạo cấu trúc bảng trong chế độ thiết kế, thao tác thực 

hiện lệnh nào sau đây là đúng? 

A. Nháy nút , rồi nháy đúp Design View  B. Nhấp đúp <tên bảng> 

C. Nháy đúp vào Create Table in Design View  D. A hoặc C 

Câu 15: Cửa sổ cấu trúc bảng được chia làm những phần nào? 

A. Phần định nghĩa trường và phần các tính chất của trường 

B. Tên trường (Field Name), kiểu dữ liệu (Data Type) và mô tả trường (Description) 

C. Tên trường (Field Name), kiểu dữ liệu (Data Type) và các tính chất của trường (Field Properties) 

D. Tên trường (Field Name), kiểu dữ liệu (Data Type), mô tả trường (Description) và các tính chất của trường 

(Field Properties) 

Câu 16: Phát biểu nào sau đây là sai? 

A. Phần định nghĩa trường gồm có: tên trường, kiểu dữ liệu và mô tả trường 



 

 

B. Mô tả nội dung của trường bắt buộc phải có 

C. Cấu trúc của bảng được thể hiện bởi các trường 

D. Mỗi trường có tên trường, kiểu dữ liệu, mô tả trường và các tính chất của trường 

Câu 17: Khi làm việc với cấu trúc bảng, để xác định tên trường, ta gõ tên trường tại cột: 

A. File Name B. Field Name C. Name Field D. Name 

Câu 18: Khi làm việc với cấu trúc bảng, để xác định kiểu dữ liệu của trường, ta xác định tên kiểu dữ 

liệu tại cột: 

A. Field Type B. Description C. Data Type D. Field Properties 

Câu 19: Trong khi tạo cấu trúc bảng, muốn thay đổi kích thước của trường, ta xác định giá trị mới tại 

dòng: 

A. Field Name B. Field Size C. Description D. Data Type 

Câu 20: Khi tạo bảng, trường “DiaChi” có kiểu dữ liệu là Text, trong mục Field size ta nhập vào số 

300. Sau đó ta lưu cấu trúc bảng lại. 

A. Access báo lỗi B. Trường DiaChi có tối đa 255 kí tự 

C. Trường DiaChi có tối đa 300 kí tự D. Trường DiaChi có tối đa 256 kí tự 

Câu 21: Giả sử trường “DiaChi” có Field size là 50. Ban đầu địa chỉ của học sinh A là “Le Hong 

Phong”, giờ ta sửa lại thành “70 Le Hong Phong” thì kích thước CSDL có thay đổi như thế nào ? 

A. Giảm xuống B. Không đổi C. Tăng lên 

Câu 22: Các trường mà giá trị của chúng được xác định duy nhất mỗi hàng của bảng được gọi là: 

A. Khóa chính   B.Bản ghi chính C.Kiểu dữ liệu  D.Trường chính 

Câu 23: Hãy chọn phát biểu đúng trong các phát biểu sau? 

A. Khi đã chỉ định khóa chính cho bảng, Access sẽ không cho phép nhập giá trị trùng hoặc để trống giá trị 

trong trường khóa chính 

B. Trường khóa chính có thể nhận giá trị  trùng nhau 

C. Trường khóa chính có thể để trống 

D. Trường khóa chính phải là trường có kiểu dữ liệu là Number hoặc AutoNumber 

Câu 24: Hãy chọn phát biểu sai  trong các phát biểu sau? 

A. Khi đã chỉ định khóa chính cho bảng, Access sẽ không cho phép nhập giá trị trùng hoặc để trống giá trị 

trong trường khóa chính 

B. Khóa chính có thể là một hoặc nhiều trường 

C. Một bảng có thể có nhiều khóa chính 

D. Có thể thay đổi khóa chính 

Câu 25: Chọn phát biểu đúng khi nói về khóa chính và bảng (được thiết kế tốt) trong access? 

A. Bảng không cần có khóa chính B. Một bảng có thể có 2 trường cùng kiểu AutoNumber 

C. Một bảng phải có một khóa chính D. Một bảng có nhiều khóa chính 

Câu 26: Để chỉ định khóa chính cho một bảng, sau khi chọn trường, ta thực hiện: 

A. Edit  Primary key B. Nháy nút  

C. A và B D. A hoặc B 

Câu 27: Trong Access, khi chỉ định khoá chính sai, muốn xóa bỏ khoá chính đã chỉ định, ta nháy chuột 

vào nút lệnh :  

A.    B.     C.    D.  

Câu 28: Trong Access, muốn thay đổi khóa chính, ta chọn trường muốn chỉ định khóa chính rồi thực 

hiện: 

A. Nháy nút   hoặc chọn Edit  Primary Key B. Nháy nút   và chọn Edit  Primary Key 

C. Nháy nút    D. Edit  Primary Key 

Câu 29: Trong khi làm việc với cấu trúc bảng, muốn xác định khóa chính, ta thực hiện : ...........  

Primary Key 

A. Insert B. Edit C. File D. Tools 

Câu 30: Khi thiết kế xong bảng, nếu không chỉ định khóa chính thì: 

A. Access đưa lựa chọn là tự động tạo trường khóa chính cho bảng có tên là ID với kiểu dữ liệu là 

AutoNumber 



 

 

B. Access không cho phép lưu bảng 

C. Access không cho phép nhập dữ liệu 

D. Dữ liệu của bảng sẽ có hai hàng giống hệt nhau 

Câu 31: Khi đang làm việc với cấu trúc bảng, muốn lưu cấu trúc vào đĩa, ta thực hiện : 

A. View – Save B. Tools – Save C. Format – Save D. File – Save 

Câu 32: Để lưu cấu trúc bảng, ta thực hiện : 

A. File  Save  B.Nháy nút   

C. Nhấn tổ hợp phím Ctrl+S D. A hoặc B hoặc C 

Câu 33: Cho các thao tác sau:  

 1. Mở cửa sổ CSDL, chọn đối tượng Table trong bảng chọn đối tượng 

 2. Trong cửa sổ Table: gõ tên trường, chọn kiểu dữ liệu, mô tả, định tính chất trường 

 3. Tạo cấu trúc theo chế độ thiết kế 

 4. Đặt tên và lưu cấu trúc bảng 

 5. Chỉ định khóa chính 

Để tạo cấu trúc một bảng trong CSDL, ta thực hiện lần lượt các thao tác: 

A.1, 3, 2, 5, 4    B.3, 4, 2, 1, 5  C.2, 3, 1, 5, 4   D.1, 2, 3, 4, 5 

Câu 34: Cấu trúc bảng bị thay đổi khi có một trong những thao tác nào sau đây? 

A. Thêm/xóa trường      

B. Thay đổi tên, kiểu dữ liệu của trường, thứ tự các trường, khóa chính 

C. Thay đổi các tính chất của trường  

D. Thêm/xóa trường, thay đổi tên, kiểu dữ liệu của trường, thứ tự các trường, khóa chính 

Câu 35: Trong chế độ thiết kế, một trường thay đổi khi: 

A.Một trong những tính chất của trường thay đổi B. Kiểu dữ liệu của trường thay đổi 

C.Tên trường thay đổi     D. Tất cả các phương án trên 

Câu 36: Chế độ trang dữ liệu, không cho phép thực hiện thao tác nào trong các thao tác dưới đây? 

A. Thêm bản ghi mới. B. Xóa bản ghi. 

C. Thêm bớt trường của bảng D. Chỉnh sửa nội dung của bản ghi. 

Câu 37: Bảng đã được hiển thị ở chế độ trang dữ liệu, muốn xóa trường đã chọn, thao tác thực hiện 

lệnh nào sau đây là đúng? 

A. Không thực hiện được B. Edit/Delete Field 

C. Edit/Delete Rows D. Insert/Rows 

Câu 38: Trong cửa sổ CSDL, muốn thay đổi cấu trúc 1 bảng, ta chọn bảng đó rồi nháy: 

A.  B.  C.  D.  

Câu 39: Trong khi làm việc với cấu trúc bảng, muốn xóa một trường đã chọn, ta thực hiện : 

A. Rows  Delete     B. RecordDelete Rows hoặc nháy nút   

C. Edit Delete Rows hoặc nháy nút   D. Edit Delete Rows hoặc nháy nút  

Câu 40: Trong khi làm việc với cấu trúc bảng, muốn chèn thêm một trường mới, ta thực hiện : 

A. Insert –> Rows B. Tools –> Insert Rows C. Edit –> Insert Rows D. File –> Insert Rows 

Câu 41: Giả sử lúc tạo cấu trúc bảng thiếu một trường, để thêm một trường không phải ở vị trí cuối ta 

chọn vị trí cần thêm, sau đó nháy nút: 

A.  B.  C.  D.  

Câu 42: Một bảng có thể có tối đa bao nhiêu trường 

A.255   B.552   C.525   D.Chỉ bị giới hạn bởi bộ nhớ 

Câu 43: Muốn xóa một bảng, ta chọn tên bảng cần xóa trong trang bảng rồi thực hiện: 

A. Nhấn phím Delete B. Nháy nút  C. Edit  Delete D. A hoặc B hoặc C 

Câu 44: Muốn đổi bảng THISINH thành tên bảng HOCSINH ta thực hiện : 

A. Nháy chọn tên THISINH / gõ tên HOCSINH. 

B. Nháy phải chuột  vào tên THISINH/ Rename / gõ tên HOCSINH. 

C. Trong chế độ thiết kế của bảng THISINH, gõ tên HOCSINH vào thuộc tính caption của trường chính. 

D. File / Rename / gõ tên HOCSINH 



 

 

Câu 45: Trong Access, muốn nhập dữ liệu vào cho một bảng, ta thực hiện : 

A. Nhập trực tiếp trong chế độ trang dữ liệu B. Nháy đúp trái chuột lên tên bảng cần nhập dữ liệu 

C. Dùng biểu mẫu  D. A hoặc B hoặc C 

ĐÁP ÁN: 

BÀI 5: CÁC THAO TÁC CƠ BẢN TRÊN BẢNG 

 

Câu 1: Cập nhật dữ liệu là: 

A. Thay đổi dữ liệu trong các bảng 

B. Thay đổi dữ liệu trong các bảng gồm: thêm bản ghi mới, chỉnh sửa, xóa bản ghi   

C. Thay đổi cấu trúc của bảng 

D. Thay đổi cách hiển thị dữ liệu trong bảng 

Câu 2: Chế độ nào cho phép thực hiện cập nhật dữ liệu trên bảng một cách đơn giản? 

A. Chế độ hiển thị trang dữ liệu   B. Chế độ biểu mẫu 

C. Chế độ thiết kế     D. Một đáp án khác 

Câu 3: Trong khi nhập dữ liệu cho bảng, muốn chèn thêm một bản ghi mới, ta thực hiện : Insert  

........... 

A. Record B. New Rows C. Rows D. New Record 

Câu 4: Muốn chèn thêm một bản ghi mới, ta thực hiện: 

A. Insert  New Record    B. Nháy nút   

C. Nháy chuột trực tiếp vào bản ghi trống ở cuối bảng rồi gõ dữ liệu tương ứng 

D. Cả 3 đáp án trên đều đúng 

Câu 5: Phát biểu nào sai trong các phát biểu sau? 

A. Có thể thêm bản ghi vào giữa các bản ghi đã có trong bảng 

B. Có thể sử dụng phím Tab để di chuyển giữa các ô trong bảng ở chế độ trang dữ liệu 

C. Tên trường có thể chứa các kí tự số và không thể dài hơn 64 kí tự 

D. Bản ghi đã bị xóa thì không thể khôi phục lại được 

Câu 6: Để xóa một bản ghi ta thực hiện thao tác nào sau đây? 

A. Chọn Insert → Delete Record rồi chọn Yes. B. Nháy  trên thanh công cụ rồi chọn Yes. 

C. Nháy   trên thanh công cụ rồi chọn Yes. D. Cả A và B đều đúng. 

Câu 7: Trong khi nhập dữ liệu cho bảng, muốn xóa một bản ghi đã được chọn, ta bấm phím: 

A. Enter B. Space C. Tab D. Delete 

Câu 8: Trong khi nhập dữ liệu cho bảng, muốn xóa một bản ghi đã được chọn, ta thực hiện: 

A. Edit/Delete B. Edit/Delete Record C. Nhấn phím Delete D. Cả 3 đáp án trên đều đúng 

Câu 9: Để sắp xếp dữ liệu trường nào đó tăng dần ta chọn biểu tượng nào sau đây? 

A. Biểu tượng  B. Biểu tượng  C. Biểu tượng  D. Biểu tượng  

Câu 10: Để sắp xếp dữ liệu trường nào đó giảm dần ta chọn biểu tượng nào sau đây? 

A. Biểu tượng . B. Biểu tượng  C. Biểu tượng  D. Biểu tượng  

Câu 11: Bảng đã được hiển thị ở chế độ trang dữ liệu, với một trường đã chọn, muốn sắp xếp các bản 

ghi theo thứ tự tăng,  thao tác thực hiện lệnh nào sau đây là đúng? 

A. Record/Sort/Sort Descending B. Insert/New Record 

C. Edit/ Sort Ascending D. Record/Sort/Sort Ascending 

Câu 12: Khẳng định nào sau đây là sai? 

A. Lọc là một công cụ của hệ QT CSDL cho phép tìm ra những bản ghi thỏa mãn một số điều kiện nào đó 

phục vụ tìm kiếm 

B. Lọc tìm được các bản ghi trong nhiều bảng thỏa mãn với điều kiện lọc 

C. Sử dụng lọc theo ô dữ liệu đang chọn để tìm nhanh các bản ghi có dữ liệu trùng với ô đang chọn 

D. Sử dụng lọc theo mẫu để tìm các bản ghi thỏa mãn các tiêu chí phức tạp 



 

 

Câu  13: Trong Access, từ Filter có ý nghĩa gì ? 

A. Tìm kiếm dữ liệu  B. Lọc dữ liệu  C. Sắp xếp dữ liệu  D. Xóa dữ liệu 

Câu 14: Để lọc dữ liệu theo ô đang chọn, ta chọn biểu tượng nào sau đây? 

A. Biểu tượng  B. Biểu tượng  C. Biểu tượng  D. Biểu tượng  

Câu 15: Cho các thao tác sau: 

(1) Nháy nút  

(2) Nháy nút  

(3) Chọn ô có dữ liệu cần lọc 

Trình tự các thao tác để thực hiện được việc lọc theo ô dữ liệu đang chọn là: 

A. (3)  (1)  (2) B. (3)  (2)  (1) C. (3)  (1) D. (3)  (2) 

Câu  16: Trong Access, muốn thực hiện việc hủy lọc dữ liệu, ta nháy nút : 

A.    B.    C.    D.  

Câu 17: Bảng đã được hiển thị ở chế độ trang dữ liệu, muốn lọc theo mẫu, thao tác thực hiện lệnh nào 

sau đây là đúng? 

A. Record/Fillter/Fillter By Form B. Insert/Colum 

C. Record/Sort/Sort Ascending D. Record/Fillter/Fillter By Selection 

Câu 18: Để lọc theo mẫu, ta chọn biểu tượng nào sau đây? 

A. Biểu tượng  B. Biểu tượng  C. Biểu tượng  D. Biểu tượng  

Câu 19: Cho các thao tác sau: 

(1) Nháy nút  

(2) Nháy nút  

(3) Nhập điều kiện lọc vào từng trường tương ứng theo mẫu 

Trình tự các thao tác để thực hiện được việc lọc theo mẫu là: 

A. (2)  (3)  (1) B. (3)  (2)  (1) C. (1)  (2)  (3) D. (1)  (3)  (2) 

 

Câu 20: Để lọc ra danh sách học sinh “Nam” trong lớp, ta thực hiện: 

A. Trên trường (Giới Tính) ta nháy nút  

B. Nháy nút , rồi gõ vào chữ (“Nam”) trên trường (Giới Tính), sau đó nháy nút  

C. Trên trường (Giới Tính) ta click chuột vào một ô có giá trị là (Nam), rồi nháy nút  

D. Cả B và C đều đúng 

Câu 21: Để lọc danh sách học sinh của hai tổ 1 và 2 của lớp 12A1, ta chọn lọc theo mẫu, trong trường 

“Tổ” ta gõ vào: 

A. 1 or  2 B. Không làm được C. 1 and 2 D. 1 , 2 

Câu 22: Trên Table ở chế độ Datasheet View, Nhấn Ctrl+F: 

A. Mở hộp thoại Font    B. Mở hộp thoại Filter  

C. Mở hộp thoại Sort    D. Mở hộp thoại Find and Replace 

Câu 23: Bảng đã được hiển thị ở chế độ trang dữ liệu, muốn tìm cụm từ nào đó trong bảng, ta thực 

hiện thao tác: 

A. Edit/ Find     B. Record/ Filter/ Filter By Selection 

C. Record/ Sort/ Sort Decending  D. Record/ Filter/ Filter By Form 

Câu 24: Để tìm kiếm và thay thế dữ liệu trong bảng ta chọn biểu tượng nào sau đây? 

A. Biểu tượng  B. Biểu tượng  C. Biểu tượng  D. Biểu tượng  

Câu 25: Trong Access, muốn in dữ liệu ra giấy, ta thực hiện 

A. Edit – Print B. File – Print C. Windows – Print D. Tools – Print 

Câu 26: Trong Access, muốn xem lại trang dữ liệu trước khi in, ta thực hiện : 

A. File – Print Preview     B. View – Print Preview    

C. Windows – Print Preview  D. Tools – Print Preview 



 

 

 

BÀI 6: BIỂU MẪU 

 

Câu 1: Để tạo biểu mẫu ta chọn đối tượng nào trên bảng chọn đối tượng?  

A. Queries  B. Forms  C. Tables  D. Reports 

Câu 2: Trong Access, ta có thể sử dụng biểu mẫu để : 

A. Tính toán cho các trường tính toán B. Sửa cấu trúc bảng 

C. Xem, nhập và sửa dữ liệu   D. Lập báo cáo 

Câu 3: Để tạo biểu mẫu, trước đó phải có dữ liệu nguồn là từ: 

A. Bảng hoặc mẫu hỏi    B. Bảng hoặc báo cáo 

C. Mẫu hỏi hoặc báo cáo   D. Mẫu hỏi hoặc biểu mẫu 

Câu 4: Trong Access, muốn tạo biểu mẫu theo cách dùng thuật sĩ, ta chọn: 

A. Create form for using Wizard  B. Create form by using Wizard 

C. Create form with using Wizard  D. Create form in using Wizard 

Câu 5: Trong Access, muốn tạo biểu mẫu theo cách tự thiết kế, ta chọn: 

A. Create form in Design View  B. Create form by using Wizard 

C. Create form with using Wizard  D. Create form by Design View 

Câu 6: Cho các thao tác: 

 (1) Gõ tên cho biểu mẫu rồi nháy Finish 

 (2) Chọn đối tượng Form trong bảng chọn đối tượng rồi nháy đúp vào Create form by using 

wizard 

 (3) Chọn kiểu cho biểu mẫu rồi nhấn Next 

 (4) Chọn cách bố trí biểu mẫu rồi nhấn Next 

 (5) Trong hộp thoại Form Wizard, chọn bảng (hoặc mẫu hỏi) từ ô Tables/Queries, tiếp theo là 

chọn các trường đưa vào biểu mẫu rồi nhấn Next 

Trình tự các thao tác để có thể thực hiện tạo biểu mẫu bằng cách dùng thuật sĩ sẽ là: 

A (2)  (5)  (3)  (4)  (1)   B. A (2)  (5)  (4)  (3)  (1) 

C. (5)  (2)  (3)  (4)  (1)   D. A (2)  (3)  (4)  (5)  (1) 

Câu 7: Các thao tác thay đổi hình thức biểu mẫu, gồm: 

A. Thay đổi nội dung các tiêu đề    B. Sử dụng phông chữ tiếng Việt 

C. Di chuyển các trường, thay đổi kích thước trường D. Cả A, B và C đều đúng 

Câu 8: Chỉnh sửa biểu mẫu (thay đổi hình thức biểu mẫu) chỉ thực hiện được ở chế độ: 

A. Thiết kế  B. Trang dữ liệu  C. Biểu mẫu  D. Thuật sĩ 

Câu 9: Phát biểu nào trong các phát biểu sau là sai? 

A. Chế độ biểu mẫu có giao diện thân thiện, thường được sử dụng để cập nhật dữ liệu 

B. Bảng ở chế độ hiển thị trang dữ liệu có thể được sử dụng để cập nhật dữ liệu 

C. Để làm việc trên cấu trúc của biểu mẫu thì biểu mẫu phải ở chế độ thiết kế 

D. Có thể tạo biểu mẫu bằng cách nhập dữ liệu trực tiếp (nháy đúp vào Create form by entering data) 

Câu 10: Trong chế độ thiết kế của biểu mẫu, ta có thể: 

A. Sửa đổi cấu trúc của biểu mẫu   B. Sửa đổi dữ liệu 

C. Nhập và sửa dữ liệu    D. Xem, sửa, xóa và nhập dữ liệu  

Câu 11: Trong chế độ thiết kế của biểu mẫu, ta có thể: 

A. Sửa đổi thiết kế cũ  

B. Thiết kế mới cho biểu mẫu , sửa đổi thiết kế cũ 

C. Thiết kế mới cho biểu mẫu, xem hay sửa đổi thiết kế cũ      

D. Thiết kế mới cho biểu mẫu, xem hay sửa đổi thiết kế cũ, xem, sửa, xóa và nhập dữ liệu  



 

 

Câu 12: Các thao tác có thể thực hiện trong chế độ thiết kế, gồm: 

A. Thêm/bớt, thay đổi vị trí, kích thước các trường dữ liệu     

B. Định dạng phông chữ cho các trường dữ liệu và các tiêu đề 

C. Tạo những nút lệnh để đóng biểu mẫu, chuyển đến bản ghi đầu, bản ghi cuối… 

D. Cả A, B và C đều đúng 

Câu 13: Để làm việc trong chế độ thiết kế của biểu mẫu, ta thực hiện: 

A. Chọn biểu mẫu rồi nháy nút  

B. Chọn biểu mẫu rồi nháy nút  hoặc nháy nút  nếu đang ở chế độ biểu mẫu 

C. Chọn biểu mẫu rồi nháy nút  và nháy nút  nếu đang ở chế độ thiết kế 

D. Chọn biểu mẫu rồi nháy nút  hoặc nháy nút  nếu đang ở chế độ thiết kế 

Câu 14: Thao tác nào sau đây có thể thực hiện được trong chế độ biểu mẫu? 

A. Thêm một bản ghi mới   B. Định dạng font chữ cho các trường dữ liệu 

C. Tạo thêm các nút lệnh   D. Thay đổi vị trí các trường dữ liệu  

Câu 15: Để làm việc trong chế độ biểu mẫu, ta không thực hiện thao tác nào sau đây? 

A. Nháy đúp chuột lên tên biểu mẫu  B. Chọn biểu mẫu rồi nháy nút   

C.  Nháy nút  , nếu đang ở chế độ thiết kế D. Nháy nút  , nếu đang ở chế độ thiết kế 

Câu 16: Để làm việc trong chế độ biểu mẫu, ta thực hiện: 

A. Nháy đúp lên tên biểu mẫu   B. Chọn biểu mẫu rồi nháy nút  

C. Nháy nút  nếu đang ở chế độ thiết kế  D. Cả A, B và C đều đúng 

Câu 17: Phát biểu nào sau đây là sai? 

A. Việc cập nhật dữ liệu trong biểu mẫu thực chất là cập nhật dữ liệu trên bảng dữ liệu nguồn 

B. Việc nhập dữ liệu bằng cách sử dụng biểu mẫu sẽ thuận tiện hơn, nhanh hơn, ít sai sót hơn 

C. Có thể sử dụng bảng ở chế độ trang dữ liệu để cập nhật dữ liệu trực tiếp 

D. Khi tạo biểu mẫu để nhập dữ liệu thì bắt buộc phải xác định hành động cho biểu mẫu 

BÀI 7: LIÊN KẾT GIỮA CÁC BẢNG 

 

Câu 1: Liên kết giữa các bảng cho phép: 

A. Tránh được dư thừa dữ liệu   C. Có thể có được thông tin tổng hợp từ nhiều bảng 

C. Nhất quán dữ liệu    D. Cả A, B, C đều đúng 

Câu 2: Để tạo liên kết giữa các bảng, ta chọn:  

A.Tool/ Relationships hoặc nháy nút    B.Tool/ Relationships 

C.Edit/ Insert/ Relationships    D.Tất cả đều đúng 

Câu 3: Sắp xếp các bước theo đúng thứ tự thực hiện để tạo liên kết giữa hai bảng: 

1. Kéo thả trường khóa làm liên kết từ bảng phụ tới bảng chính( trường khóa làm khóa chính) 

2. Chọn các tham số liên kết 

3. Hiển thị hai bảng (các trường) muốn tạo liên kết 

4. Mở cửa sổ Relationships 

A. 2413  B. 4312  C. 4231  D. 3142 

Câu 4: Các bước để tạo liên kết giữa các bảng là: 

  1. Chọn Tool\Relationships… 

  2. Tạo liên kết đôi một giữa các bảng 

  3. Đóng hộp thoại Realationships/ Yes để lưu lại 

  4. Chọn các bảng sẽ liên kết 

A.1, 4, 2, 3   B.2, 3, 4, 1  C.1, 2, 3, 4   D.4, 2, 3, 1  

Câu 5: Khi muốn thiết lập liên kết giữa hai bảng thì mỗi bảng phải có: 



 

 

A. Khóa chính giống nhau   B. Số trường bằng nhau 

C. Số bản ghi bằng nhau   D. Tất cả đều sai 

Câu 6: Trong Access, để tạo liên kết giữa 2 bảng thì hai bảng đó phải có hai trường thỏa mãn điều 

kiện: 

A. Có tên giống nhau    B. Có kiểu dữ liệu giống nhau 

C. Có ít nhất một trường là khóa chính D. Cả A, B, C 

Câu 7: Trong Access, khi tạo liên kết giữa các bảng, thì : 

A. Phải có ít nhất một trường là khóa chính                    B. Cả hai trường phải là khóa chính 

C. Hai trường không nhất thiết phải là khóa chính          D. Một trường là khóa chính, một trường không 

Câu 8: Điều kiện cần để tạo được liên kết là: 

A. Phải có ít nhất hai bảng  B. Phải có ít nhất một bảng và một mẫu hỏi 

C. Phải có ít nhất một bảng mà một biểu mẫu D. Tổng số bảng và mẫu hỏi ít nhất là 2 

Câu 9: Điều kiện để tạo mối liên kết giữa hai bảng là : 

A. Trường liên kết của hai bảng phải cùng kiểu dữ liệu   B. Trường liên kết của hai bảng phải là chữ hoa 

C. Trường liên kết của hai bảng phải là kiểu dữ liệu số    D. Trường liên kết của hai bảng phải khác nhau về 

kiểu dữ liệu 

Câu 10: Tại sao khi lập mối quan hệ giữa hai trường của hai bảng nhưng Access lại không chấp nhận 

A. Vì bảng chưa nhập dữ liệu 

B. Vì một hai bảng này đang sử dụng (mở cửa sổ table) 

C. Vì hai trường tham gia vào dây quan hệ khác kiểu dữ liệu(data type), khác chiều dài (field size) 

D. Các câu B và C đều đúng 

Câu 11: Khi liên kết bị sai, ta có thể sửa lại bằng cách chọn đường liên kết cần sửa, sau đó: 

A. Nháy đúp vào đường liên kết  chọn lại trường cần liên kết  

B. Edit  RelationShip 

C. Tools  RelationShip  Change Field  

D. Chọn đường liên kết giữa hai bảng đó và nhấn phím Delete 

Câu 12: Muốn xóa liên kết giữa hai bảng, trong cửa sổ Relationships ta thực hiện: 

A. Chọn hai bảng và nhấn phím Delete 

B. Chọn đường liên kết giữa hai bảng đó và nhấn phím Delete 

C. Chọn tất cả các bảng và nhấn phím Delete 

D. Cả A, B, C đều sai 

Câu 13: Để xóa liên kết, trước tiên ta chọn liên kết cần xóa. Thao tác tiếp theo nào sau đây là sai? 

A. Bấm Phím Delete  Yes  B. Click phải chuột, chọn Delete  Yes 

C. Edit  Delele  Yes  D. Tools  RelationShip  Delete  Yes 

 

 

BÀI 8: TRUY VẤN DỮ LIỆU 

 

Câu 1: Truy vấn dữ liệu có nghĩa là: 

A. In dữ liệu     C. Tìm kiếm và hiển thị dữ liệu 

B. Cập nhật dữ liệu    D. Xóa các dữ liệu không cần đến nữa 

Câu 2: Nếu những bài toán mà câu hỏi chỉ liên quan tới một bảng, ta có thể: 

A. Thực hiện thao tác tìm kiếm và lọc trên bảng hoặc biểu mẫu B. Sử dụng mẫu hỏi 

C. A và B đều đúng       D. A và B đều sai 

Câu 3: Nếu những bài toán phức tạp, liên quan tới nhiều bảng, ta sủ dụng: 

A. Mẫu hỏi   B. Bảng  C. Báo cáo   D. Biểu mẫu 

Câu 4: Để hiển thị một số bản ghi nào đó trong cơ sở dữ liệu, thống kê dữ liệu, ta dùng: 

A. Mẫu hỏi   B. Câu hỏi  C. Liệt kê   D. Trả lời 

Câu 5: Trước khi tạo mẫu hỏi để giải quyết các bài toán liên quan tới nhiều bảng, thì ta phải thực hiện 

thao tác nào? 

A. Thực hiện gộp nhóm    B. Liên kết giữa các bảng 

C. Chọn các trường muốn hiện thị ở hàng Show D. Nhập các điều kiện vào lưới QBE 

Câu 6: Mẫu hỏi thường được sử dụng để: 

A. Sắp xếp các bản ghi, chọn các trường để hiển thị, thực hiện tính toán 

B. Chọn các bản ghi thỏa mãn điều kiện cho trước 

C. Tổng hợp và hiển thị thông tin từ nhiều bảng hoặc mẫu hỏi khác 

D. Cả A, B và C 



 

 

Câu 7: Các chế độ làm việc với mẫu hỏi là: 

A. Mẫu hỏi      B. Mẫu hỏi và thiết kế    

C. Trang dữ liệu và thiết kế    D. Trang dữ liệu và mẫu hỏi 

Câu 8: Kết quả thực hiện mẫu hỏi cũng đóng vai trò như: 

A. Một bảng  B. Một biểu mẫu C. Một báo cáo  D. Một mẫu hỏi 

Câu 9: Kết quả thực hiện mẫu hỏi có thể tham gia vào việc tạo ra: 

A. Bảng, biểu mẫu, mẫu hỏi hay báo cáo 

B. Bảng, biểu mẫu khác, mẫu hỏi khác hay các trang khác 

C. Bảng, biểu mẫu, mẫu hỏi khác hay báo cáo 

D. Bảng, biểu mẫu, mẫu hỏi khác 

Câu 10: “ /” là phép toán thuộc nhóm: 

A. Phép toán so sánh  B. Phép toán số học C. Phép toán logic D. Không thuộc các nhóm trên 

Câu 11: “ >=” là phép toán thuộc nhóm: 

A. Phép toán so sánh  B. Phép toán số học C. Phép toán logic D. Không thuộc các nhóm trên 

Câu 12: “ not” là phép toán thuộc nhóm: 

A. Phép toán so sánh  B. Phép toán số học C. Phép toán logic D. Không thuộc các nhóm trên 

Câu 13: Phát biểu nào sai trong các phát biểu sau khi nói về mẫu hỏi? 

A. Biểu thức số học được sử dụng để mô tả các trường tính toán  

B. Biểu thức logic được sủ dụng khi thiết lập bộ lọc cho bảng, thiết lập điều kiện lọc để tạo mẫu hỏi 

C. Hằng văn bản được viết trong cặp dấu nháy đơn 

D. Hàm gộp nhóm là các hàm như: SUM, AVG, MIN, MAX, COUNT  

Câu 14: Để xem hay sửa đổi thiết kế của mẫu hỏi, trước tiên ta chọn mẫu hỏi rồi nháy nút: 

A.    B.   C.   D.  hoặc  

Câu 15: Cửa sổ mẫu hỏi ở chế độ thiết kế gồm hai phần là: 

A. Phần trên (dữ liệu nguồn) và phần dưới (lưới QBE) 

B. Phần định nghĩa trường và phần khai báo các tính chất của trường 

C. Phần chứa dữ liệu và phần mô tả điều kiện mẫu hỏi 

D. Phần tên và phần tính chất 

Câu 16: Khi xây dựng các truy vấn trong Access, để sắp xếp các trường trong mẫu hỏi, ta nhập điều 

kiện vào dòng nào trong lưới QBE? 

A. Criteria   B. Show  C. Sort       D.Field 

Câu 17: Trong lưới QBE của cửa sổ mẫu hỏi (mẫu hỏi ở chế độ thiết kế) thì hàng Criteria có ý nghĩa 

gì? 

A. Mô tả điều kiện để chọn các bản ghi đưa vào mẫu hỏi  

B. Xác định các trường xuất hiện trong mẫu hỏi 

C. Xác định các trường cần sắp xếp 

D. Khai báo tên các trường được chọn 

Câu 18: Bảng DIEM có các trường MOT_TIET, HOC_KY. Để tìm những học sinh có điểm một tiết 

trên 7 và điểm thi học kỳ trên 5 , trong dòng Criteria của trường HOC_KY, biểu thức điều kiện nào 

sau đây là đúng: 

A. MOT_TIET > 7 AND HOC_KY >5   B. [MOT_TIET] > 7 AND [HOC_KY]>5 

C. [MOT_TIET] > 7 OR [HOC_KY]>5  D. [MOT_TIET] > "7" AND [HOC_KY]>"5" 

Câu 19: Bảng DIEM có các trường MOT_TIET, HOC_KY. Trong Mẫu hỏi, biểu thức số học để tạo 

trường mới TRUNG_BINH, lệnh nào sau đây là đúng: 

A. TRUNG_BINH:(2* [MOT_TIET] + 3*[HOC_KY])/5         

B. TRUNG_BINH:(2* MOT_TIET + 3*HOC_KY)/5 

C. TRUNG_BINH:(2* [MOT_TIET] + 3*[HOC_KY]):5           

D. TRUNG_BINH=(2* [MOT_TIET] + 3*[HOC_KY])/5 

Câu 20: Khi hai (hoặc nhiều hơn) các điều kiện được kết nối bằng AND hoặc OR, kết quả được gọi là: 

A. Tiêu chuẩn đơn giản    B. Tiêu chuẩn phức hợp 

C. Tiêu chuẩn mẫu     D. Tiêu chuẩn kí tự 

Câu 21: Để thêm hàng Total vào lưới thiết kế QBE, ta nháy vào nút lệnh: 

A.    B.    C.   D.  

Câu 22: Để thực hiện mẫu hỏi ( đưa ra kết quả của truy vấn) ta có thể sử dụng cách nào sau đây?  

A. Nháy nút             C.  Nháy nút  



 

 

B. Chọn lệnh View Datasheet View D.  Cả 3 cách trên đều đúng 

Câu 23: Nếu thêm nhầm một bảng làm dữ liệu nguồn trong khi tạo mẫu hỏi, để bỏ bảng đó khỏi cửa 

sổ thiết kế, ta thực hiện: 

A. Edit Delete      B. Query Remove Table 

C. Chọn bảng cần xóa rồi nhấn phím Backspace  D. Tất cả đều đúng 

Câu 24: Để thêm bảng làm dữ liệu nguồn cho mẫu hỏi, ta nháy nút lệnh: 

A.    B.    C.   D.  

Câu 25: Trong cửa sổ CSDL đang làm việc, để mở một mẫu hỏi đã có, ta thực hiện : 

A.Queries/ Nháy đúp vào tên mẫu hỏi.   B.Queries/ nháy nút Design. 

C.Queries/ Create Query by using Wizard  D.Queries/ Create Query in Design Wiew. 

Câu 26: Trong cửa sổ CSDL đang làm việc, để tạo một Mẫu hỏi mới bằng cách dùng thuật sĩ, thao 

tác thực hiện lệnh nào sau đây là đúng? 

A. Chọn Tables /Create Table in Design View  B. Chọn Queries/Create Query by using wizard 

C. Chọn Queries/Create Query in Design View D. Chọn Forms /Create Form by using wizard 

Câu 27: Trình tự thao tác để tạo mẫu hỏi bằng cách tự thiết kế, biết: 

           (1) Chọn bảng hoặc mẫu hỏi khác làm dữ liệu nguồn 

 (2) Nháy nút  

(3) Nháy đúp vào Create query in Design view 

(4) Chọn các trường cần thiết trong dữ liệu nguồn để đưa vào mẫu hỏi 

(5) Mô tả điều kiện mẫu hỏi ở lưới QBE 

A. (1) -> (3) -> (4) -> (5) ->(2)   B. (3) -> (1) -> (4) -> (5) ->(2) 

C. (3) -> (1) -> (5) -> (4) ->(2)   D. (3) -> (4) -> (5) -> (1) ->(2) 

Câu 28: Phát biểu nào sau đây là sai khi nói về mẫu hỏi? 

A. Trên hàng Field có tất cả các trường trong các bảng liên quan đến mẫu hỏi 

B. Ngầm định các trường đưa vào mẫu hỏi đều được hiển thị 

C. Có thể thay đổi thứ tự các trường trong mẫu hỏi 

D. Avg, Min, Max, Count là các hàm tổng hợp dữ liệu 

Câu 29: Phát biểu nào sau đây là đúng khi nói về mẫu hỏi? 

A. Lưới QBE là nơi người dùng chọn các trường để đưa vào mẫu hỏi, thứ tự sắp xếp và xác định điều kiện 

B. Thứ tự sắp xếp cần được chỉ ra ở hàng Total 

C. Mỗi trường trên hàng Field chỉ xuất hiện đúng một lần 

D. Mỗi mẫu hỏi phải dùng hai bảng dữ liệu nguồn trở lên 

 

 

BÀI 9: BÁO CÁO VÀ KẾT XUẤT BÁO CÁO 

 

Câu 1: Khi cần in dữ liệu theo một mẫu cho trước, cần sử dụng đối tượng: 

A. Báo cáo  B. Bảng   C. Mẫu hỏi   D. Biểu mẫu 

Câu 2: Báo cáo thường được sử dụng để: 

A. Thể hiện được sự so sánh  và tổng hợp thông tin từ các nhóm dữ liệu 

B. Trình bày nội dung văn bản theo mẫu quy định 

C. A và B đều đúng 

D. A và B đều sai 

Câu 3: Để tạo một báo cáo, cần trả lời các câu hỏi gì? 

A. Báo cáo được tạo ra để kết xuất thông tin gì? Dữ liệu từ những bảng, mẫu hỏi nào sẽ được đưa vào báo 

cáo? Dữ liệu sẽ được nhóm như thế nào? 

B. Báo cáo được tạo ra để kết xuất thông tin gì? Dữ liệu từ những bảng, mẫu hỏi nào sẽ được đưa vào báo 

cáo? Dữ liệu sẽ được nhóm như thế nào? Tạo báo cáo bằng cách nào? 

C. Báo cáo được tạo ra để kết xuất thông tin gì? Dữ liệu từ những bảng, mẫu hỏi nào sẽ được đưa vào báo 

cáo? Dữ liệu sẽ được nhóm như thế nào? Hình thức báo cáo như thế nào? 

D. Báo cáo được tạo ra để kết xuất thông tin gì? Dữ liệu từ những bảng, mẫu hỏi nào sẽ được đưa vào báo 

cáo?  

Câu 4: Để làm việc với báo cáo, chọn đối tượng nào trong bảng chọn đối tượng? 

A. Tables  B. Forms   C. Queries   D. Reports 

Câu 5: Để tạo nhanh một báo cáo, thường chọn cách nào trong các cách dưới đây: 

A. Người dùng tự thiết kế 



 

 

B. Dùng thuật sĩ tạo báo cáo 

C. Dùng thuật sĩ tạo báo cáo và sau đó sửa đổi thiết kế báo cáo được tạo ra ở bước trên 

D. Tất cả các trên  đều sai 

Câu 6: Đối tượng nào sau đây không thể cập nhật dữ liệu? 

A. Bảng, biểu mẫu  B. Mẫu hỏi, báo cáo  C. Báo cáo  D. Bảng 

Câu 7: Giả sử bảng HOCSINH gồm có các trường MAHS, HOTEN, DIEM. LOP. Muốn hiển thị thông 

tin điểm cao nhất của mỗi lớp để sử dụng lâu dài, trong Access ta sử dụng đối tượng nào trong các đối 

tượng sau? 

A. Reports   B. Queries   C. Forms       D. Tables 

Câu 8: Khi muốn sửa đổi thiết kế báo cáo, ta chọn báo cáo rồi nháy nút: 

A.   B.   C.    D.  

Câu 9: Khi báo cáo đang ở chế độ thiết kế, có thể nháy nút nào để xem kết quả của báo cáo? 

A.   B.   C.    D.  

Câu 10: Khi mở một báo cáo, nó được hiển thị dưới dạng nào? 

A. Chế độ thiết kế B. Chế độ trang dữ liệu C. Chế độ biểu mẫu D. Chế độ xem trước 

Câu 11: Chọn phát biểu sai trong các phát biểu sau? 

A. Có thể định dạng kiểu chữ, cỡ chữ cho các tiêu đề và dữ liệu trong báo cáo 

B. Lưu báo cáo để sử dụng nhiều lần 

C. Báo cáo tạo bằng thuật sĩ đạt yêu cầu về hình thức 

D. Có thể chèn hình ảnh cho báo cáo thêm sinh động 

Câu 12: Với báo cáo, ta không thể làm được việc gì trong những việc sau đây? 

A. Chọn trường đưa vào báo cáo  B. Lọc những bản ghi thỏa mãn một điều kiện nào đó  

C. Gộp nhóm dữ liệu    D. Bố trí báo cáo và chọn kiểu trình bày 

  


